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Introduction
Welcome to the SOFv InDesign workshop! The 
workshop will consist of two parts: part A and 
part B. First I will elaborate on InDesign, and 
then I go into detail on the two parts.

About InDesign
InDesign is an Adobe program, meaning it is 
from the same authors as the famous Photo-
shop and Illustrator. These are the three main 
programs that you will use when creating visual 
media. They are rather similar; they even use 
the same lay-out. Fun fact: on most university 
pc’s, they come pre-installed. Buying it yourself 
is actually quite an investment.
Each of the three programs is capable of do-
ing very simple tasks, such as moving pictures, 
making textboxes and drawing lines. However, 
if you want to get more in-depth, you will need 
to pick one of the three. Below I will elaborate 
a bit on when you should pick InDesign, and 
when you should consider using Photoshop or 
Illustrator.

When do you use Photoshop?
Photoshop is the best for making heavy graph-
ical edits, especially to existing photos. There-
fore, this piece of software has the biggest range 
of effects, filters and graphical editing tools.

When do you use Illustrator?
Illustrator is actually the program you will prob-
ably need the least. This is where you make 
‘drawings’; think of logo’s or your own fonts. 
Everything that has to do with vectors is edited 
most effectively in illustrator. Do not worry if you 
have no clue what those are.

When do you use InDesign?
Well then, here we are. Why would you ever 
need InDesign? I also wondered myself one 
day. InDesign is by far the most useful program 
when it comes to making consistent lay-outs 
and when you do quite some text-heavy work. 
Think of (year-)books, forms, newsletters, etc. 
Even the RAGweek calendar is made in InDe-
sign! In short, if you want a lot of pages with 

roughly the same lay-out, only different con-
tents: InDesign is your best friend.

Part A
Part A of the workshop is for those totally new 
to InDesign. You will learn, amongst others, the 
following:
• Finding your way in InDesign
• Everything about working with text and text-

boxes
• Everything about working with images
• The basics on Mastersheets
• The basics on Layers
• Working with figures
• The basics on exporting

Part B
The second part of the Workshop is, as you 
probably guessed, for those with a bit more ex-
perience in InDesign. This part will discuss a lit-
tle more advanced topics, such as:
• Advanced text options
• Groups
• More on Mastersheets
• Interactive PDFs
• Adobe Integration
• Exporting, printing, etc. for experts

During the workshop itself I will be walking 
around and answering questions. Don’t hesitate 
to ask any questions, I thoroughly enjoy help-
ing out and you will be able to move on faster. 
Sounds like a solid deal.

I made this ‘booklet’ especially for the English 
workshop; if you find any unclarities or mis-
takes, let me know. The images used are from 
the Dutch one; all essential terms are in English 
and the jokes are in very basic Dutch. Hopefully 
you will also pick up on some Dutch culture!
I will submit the edited version later so you can 
have a look at it yourself all year, e.g. for refer-
ence. 
I hope you will be learning a lot!
Best of luck,
Jorrit

Part A
Finding your way in InDesign
For those who are just starting out, it’s important to know what buttons are where. In this part I will 
clarify what most buttons do, or where you have to look if you want to do a similar adjustment. Go 
ahead and make a new document of size A4.

On the picture above you will see my screen. I will explain the colours later. To ensure we have 
the same screen lay-out, first create a new A4 file (default settings). You will also have to go to 
“Window -> work space -> reset essentials”. If you are not on a RU PC, double check whether you 
have the “creative cloud” (CC) version. Lastly, press “Control + Alt + H” to maximize the display 
quality. Okay, onto the boxes.

Red
All the way on the left of the screen, you see the most important buttons; your ‘tools’. They all have 
an icon, name and a keyboard short-cut (for the quick kids out there). The selection tool, the top 
one, is (like any other tool) selectable by clicking on it. Specifically, you can also press “V”. This 
tool is used to drag things around, edit sizes, and much more. You will be using this one the most 
often.

Other than the selection tool, you will also be using the text- and shape tool quite a lot this 
workshop. When you are able to use these effectively, you are already capable of making very 
professional-looking stuff. The rest of the tools make your life easier, but during this workshop 
we will only be discussing these three. I do recommend, however, to experiment with the many 
remaining tools once you get the hang of the basics. If you might ever have something more 
specific in mind, you have a more expanded toolbox to perhaps get it done with.

The text tool is recognizable by the big T, which also happens to be the keyboard shortcut of 
this tool. With this you can create and edit textboxes, so it is very important. The next part will 
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therefore be in a lot of detail on this. 

We also have the shape tool. With this you can create all kinds of shapes, such as rectangles and 
circles. Very useful to make your design look more stylish and interesting. We’ll also pay some 
attention to this: get ready. 

At the bottom of the menu marked in red, you can also find something on colours. This is your 
temporary colour pallet. The top colour is the one you currently selected (currently none, visible 
by the red diagonal line), and the secondary colour is black. If you double click on any of these, 
you can edit them. If you ever want to give something a colour quickly, you can use one of your 
two colours from the temporary pallet. We’ll pay more attention to colour later, so don’t worry if this 
comes across as a lot of info.

Yellow
The yellow part is your canvas. On this you see the A4 that you created, and some rulers at the 
top and bottom. You will use these later to create your guides.
On this page, you will also see a purple square. These are your margins. Currently you have 
the default margins enables; totally fine. It’s important to keep all essential information within the 
margins (faces of people, text, etc.) so they don’t end up in the fold or too much to the side. 
On top you have some tabs. May you have multiple files open, you will be able to swap documents 
by simply clicking on them.

Lastly, a fun tip: when working in InDesign, all objects have borders. These are only visible when 
editing, so you know the area of the object. However, if you want to know what your printed 
document would look like (=without all the borders), you can press ‘W’, entering ‘preview mode’. 
This also gets rid of the margins. You can go back by pressing ‘W’ again.

Green
All the way on the right you see some more buttons. Most of them speak for themselves, but I will 
go over it briefly just in case.
If you click on pages, you will get an overview of all pages that you created. You currently only 
have one, but once the document grows bigger, you can use this to create and edit pages, or even 
some other interesting edits.

There’s also a button called ‘layers’. This is so useful, that there’s a complete section on this later 
on. However, it is therefore also rather important that you are aware of how layers work. I made an 
example below. On the left you see the layers, and on the right is the result. Imagine looking from 
the top: you see layer 1 first, the fifth one last. Because layer 3 is ‘hidden’ under the contents of 
layer 1 and 2, you are not able to see the yellow. Even though layer 5 spans over the full canvas, 

there’s only little that lets it through. Imagine this as your background for instance
Lastly, on the same menu: links are references to files on your PC, such as pictures. If you add a 
picture, InDesign will have to keep track of where it is at, what the file size is, etc. Once you move 
the picture without telling InDesign, it will complain (“missing link”).
The other three buttons have to do with colours and fills, we will go into detail on this in the shapes 
section.

Blue
Just like in any other piece of software, this menu is at the top. The 78% (at least, on my screen), 
indicates how far you are zoomed in. The rest speaks for itself, but it is important to not forget that 
this exists.

Orange
Lastly, we have this part of the screen. This displays all kinds of settings of the object you are 
currently editing. If you have the selection tool selected, it will display the same as on my screen. 
However, when using the text tool for example, this bar contains totally different settings.

The basics of text
Finally. We can begin. Make sure you have the text tool selected. Now, move your mouse to 
somewhere on the sheet. Click once, keep it pressed, and drag the mouse to another part of the 
screen to draw a rectangle. If you are satisfied with the size, you can release the mouse. You can 
now double-click in the textbox to type some text.

Your text probably looks very boring now. You are using the standard font on the standard size. 
You can edit the fonts and sizes of selected text at the top left of your screen. Under the font, you 
may, dependent on the font, even select italic, bold, or anything else. Also you are able to edit the 
font size, right of the font selection. See the picture above.

Editing the font settings per piece of text for the 
entire document is a bit ridiculous. On top of that, 
you probably had some style in mind for all headers 
of your document. In word, there’s this “Header 1” 
button, pre-set per style. InDesign also has this 
functionality. However, you first have to define them 
yourself.

Such a font style is called a character style. As the 
picture suggests, you click on the A and then on 
“new character style”.

Next, go to the “basic character formats” option 
in the menu. Go ahead and select your favourite 
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font at font family. Feel free to include some other options too. Don’t forget to give your style a 
meaningful name. 

You can click OK now to confirm your style. If you select your piece of text now, and click on the 
dropdown (like on the menu below), you will be able to select and apply the style to your selected 
text. As you can see, my text is now Arial Black, size 24. Fun fact: that is the same font as Kakhiel 
uses (look that up in your free time). 

Now make another one of those 
styles, but for your main (core / 
body) text.

Someone once came up with 
a useful tool: a generator of 
nonsense Latin text that uses all kinds of word- and sentence lengths, characters, etc. This way, 
you can easily test out how your font style would look on some bigger piece of text, without 
actually having proper content. You can generate text on https://lipsum.com. Click on “generate” 
roughly halfway on the website, and copy paste the text. Put it under your header, like so:

Make sure you applied the body-character style you just 
created. What you will probably have, unless you created 
an insanely large textbox earlier, is that your text doesn’t fit 
into the box. There’s two solutions here: either make your 
box bigger, or something more exciting, you can make a 
new textbox that automatically contains all the left-over text. 

You can do the letter by clicking the red plus at the bottom-
right (this indicates that your text does not fit), and now 
InDesign wants you to draw a new rectangle. 

Try recreating the picture on the left. You should be able 
to do it by only clicking the plus-symbol and drawing some 
rectangles.

The best part is, is that once you add some more text in between, the rest of the text will automatically 

jump to the other boxes. If you are using multiple columns or pages, for example, you can still use 
the ‘same’ textbox. What you might also have noticed, is that InDesign perfectly knows how to cut 
off words at the end of a sentence using ‘-‘. This is illustrated even better if you enable the option 
that the text aligns to both sides of the textbox, as indicated in the picture below. 
Something you may come across in the future, is that a line break (or “empty line”) is just a tad too 
big or small. In InDesign, you can customize the distance between two lines. Below you can see 
an example with numbers 1 to 3, pointing at different sizes of empty space.
1. No white line.
2. Whitespace created using the button indicated in the top left. You can customize the 
distance very precisely here.
3. A white line using enters.

Back to character styles, for the last time. Did I already mention that if you change the style, all 
text in the document that use this style will automatically get adapted? This allows you to easily 
compare different fonts, etc.
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On top of just creating a brand-new 
style, you can also, in the ‘general’ 
part of the character style menu, make 
a style based off another one. This 
copies all the settings of the indicated 
style, after which you can overwrite 
any of the settings you want to alter for 
the new style. This is useful for when 
you, for instance, want your headers 
the same style as your body text, but 
just a bit bigger and in bold. While 
experimenting you can just adapt the 
font of the body, and the InDesign will 
also change the headers. 

Are you able to recreate the picture below? Tip: you can create bullet points by clicking all the way 
on the right in the text settings; you should see a familiar-looking bullet point button there. 

The last thing I want to mention on text, before we move on to the next section, is special characters. 
These are words/sentences that vary depending on your document or its place in the document. 
Think of page numbers; these are dependent on the page they’re on. There exists a button for 
this; have a look around all the special characters you can insert. 

Working with images
We are finally going to make the document look more fun, using some colourful pictures. First, 
create a new empty page which we can then decorate. You can create one using the button 
indicated on the left; click it twice.
If you scroll down on your canvas, you will see that we created two new pages.

What may surprise you, is that they are next to 
one another, whereas the first page was single. 
This is because that page was the front of our 
document. Usually, documents have a single 
front and ending page.

In the workshop folder, you can find some 
pictures that I selected in a childish mood. 
You can simply click-and-drag the picture into 
InDesign. Make sure you unzipped the folder. 

Once you return to InDesign, you will see that 
your cursor looks different. InDesign is waiting 
for you to draw a rectangle in which the picture 
can be stored. I added our cute friend Mark 
Rutte. Notice that the bar on top displays other 
settings now, as we selected a picture! 

Now we arrive at one of the less intuitive things 
about InDesign: the difference between pictures 
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and frames. Imagine a physical painting and a frame: you can choose any size of frame, and 
then align the painting behind your frame somewhere. In InDesign you can edit the two of these 
separately too. 

Once the borders around the object are blue, this means you 
are editing the frame. If you try moving the borders (using 
the selection tool), you will see that Mark won’t shrink in size. 
If you double click on Mark, you will see that the borders 
turn orange, as shown on the right. Now we know that we 
are moving the picture itself, and not the frame. Just like the 
painting and the frame: the painting is not visible outside of 
the picture frame. On the bottom left of this page you can 
see an example of this. Put our friend Mark back for the next 
few steps.

You can also make the edges of our frame rounded. This 
can be done with text frames too. By clicking yellow button 
on the border, yellow diamonds will appear on the corners. 
By dragging one of these inwards (as shown on the next 
page), you will be able to smoothen the corners.

Now, create a textbox under the picture of Mark, in which you include the caption of the picture. 
While moving elements in presence of other elements, you will see some green lines appear. 
These make sure that your alignment is correct, ensuring your design looks neater.
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Now you know how to add pictures, you can now try to recreate the picture below. 

Tip: if you want to rotate a picture, then go to your selection tool and move your mouse to the cor-
ner of the box. You will see that at some point your cursor will turn into some rotating icon; if you 
then click and drag into the right direction, you can see the picture turning.

Tip: if you hold shift while dragging, rotating, or whatever: your computer will start helping you out. 
While dragging, it will only use straight angles, whereas during rotation it will also use standard 
angles such as 30 degrees and increments of it. Holding shift while resizing images will ensure 
the aspect ratio of the image stays the same.

Tip: sometimes, you do not want the text to start at the very top of your text box, 
but have the center of the text in the middle. If you select the textbox using the 
selection tool, you will see the symbols as shown on top. The option of the bot-
tom left will ensure that the text is aligned to the middle of the box!

Lastly, InDesign has a range of special effects that you can apply to your objects. If you right-click, 
go to “Effetcs” -> “Drop Shadow“, you can for instance add some shadow. 
May you, while editing the shadows, want to know what you are doing: you can enable the pre-
view box on the bottom left. I am not going to explain what every button on here does, but the 
things you should mostly be touching are the opacity, the distance, the size, and the spread. Try 
out what these options do, and perhaps look around what else is out there.

Mastersheets
We will now move on to a more abstract concept, Mastersheets. Imagine that for each page you 
want to use the same guidelines and proportions between them, as well as a page number on the 

exact same spot on each page, and perhaps a back-
ground. How?

Our heroes from Adobe thought of something in this 
case: Mastersheets. Just like we had styles for our 
texts, we can have ‘styles’ for pages. On these styles, 
you try to minimize the specific contents, and maximize 
the number of shared objects. For instance, each page 
should have the same background and page number.

You can find Mastersheets under your “pages” menu. 
You can make a new one by rightclicking on the top half 
of the window, and licking on “new master”.

We are now going to make a mastersheet with all kinds 
of guidelines and indeed a pagenumber. 

Below is demonstrated how to make a guideline. You 
drag, from the ruler on the side, a guideline onto your 
sheet. You can now, when dragging around objects on 
your sheet, stick them exactly to the ruler, making for a 
consistent design.

One more thing: there are two ‘kinds’ of guidelines. 
Ones that are on one page only and go to the edge, and 
ones that reach both pages and also go over the edge 
of the sheet. I usually use the latter. To achieve this, 
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you need to carefully watch where your mouse 
is when you release the guideline when creating 
it. If your cursor is on the sheet, you will have 
the first type, whereas if you have it outside, you 
will get the second type. Below you can find an 
example.

Try recreating the grid below!

Now we made this grid, we can apply 
this to our pages, after which you can, 
if you feel like it, line everything up to 
the guidelines.

On the next page is shown how you 
can apply your mastersheet to our 
beautiful document. You select a 
mastersheet from the pages menu, 
and you drag it onto one of the pages 
of the document (as shown below). If 
you did it correctly, you will see that 
the page will have a B on it in the 
overview too. This means that the 
page has mastersheet type B. 

This works not only with lines, but also with text or images. 
As explained before, you can make a textbox with a 
textvariable. If you put the page number in there (on the 
mastersheet), you will see that every type B page will 
have a pagenumber. It is important to realize that sheets 
have a right and left page, and applying mastersheet R 
to a regular L page won’t work. 

If you go back to page 2 and 3, you will see that our 
pages have page numbers, which you cannot edit on the 
pages themselves.

Imagine that you are making an almanac, and that 
you want a different background for each section, but 
you want your page numbers on the same spot. That’s 
possible too! You can make a new mastersheet, and 

make it ‘based on master B’.

It works just likes with character styles, but a 
bit different: in this case, all elements visible on 
B will also appear on your new mastersheet, 
and you can only add elements. You will not 
be able to easily edit the contents on the new 
page itself. (You will learn that in part B).

I chose this background, and added it as a picture to the C-master. It is quite a dark background, 
which can make it hard to read black text. I went to effect settings, and lowered the opacity to use 
more of the white colour from the background.
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An intermezzo
During last year’s workshop, there was some unclarity on what Mastersheets actually are, and 
how you effectively use them. Therefore, I added these pages later on with some more explanation 
and examples, to make it a bit more understandable.

A mastersheet is a sort of blueprint that you can apply to an actual page. You can easily make 
copies of things you want the same.This way, you can easily make copies of common elements 
and apply it throughout your entire document. It’s like a building plan for a house: you can have 
multiple houses with the same structure, but the contents depend on the person.

So, you want your mastersheet as general as possible, so that you can apply it as many times as 
possible. Things that are on a mastersheet are, therefore:
• Page numbers
• Guidelines
• Backgrounds
• Frames

You can make infinitely many mastersheets. Do realise, however, that if you make a mastersheet 
that you apply only once, it is not needed to make a mastersheet. Mastersheets are there to 
enable “mass production“. 

A mastersheet is also an actual sheet, with a left and right page. You can only apply the left pages 
of a mastersheet to left pages, and the same with right pages. If your page numbers are only of 
the left of your mastersheet, and you apply it to a full sheet: the right page will not incude any page 
numbers.

Just like character styles, mastersheets are hierarchical. Later on in this workshop I also cover 
this, but to approach it differently: if sheet B inherits all settings from sheet A, then sheet B is just a 
more specific of type A. You can have type A only contain your page numbers and guidelines, and 
from there on build 5 different mastersheets that use these all in a little different way.

You e.g. want every interview page to have a different layout than your picture pages, however 
you do want your page numbers to be on the same location. If you want this, using this inheritance 
is the way to go.

You can also make another sheet that inherits everything from B (who inherited everything from 
A), etc. etc. You can make your sheets more and more specific along the way, saving you a lot 
of work. It is quite some work, but it really pays off if you plan your mastersheets ahead before 
starting your document.

Writing and designing are two totally different processes. By far most committees that I have seen 
work with InDesign tackle this as follows:

1. Writers write in software of choice
2. That gets checked
3. Another group applies this text to the mastersheets
4. The head-designer checks this
5. Done!

Above, you can see the mastersheet on which my almanac committee once based our first 
almanac. We began by drawing all the guidelines: we wanted to always have the text in either 
one or two columns. We also gave each ‘category’ of guidelines another colour, to clearly indicate 
what is what. I will now refer to this sheet as A1.

Next, we used another background for each section: so we also had to use a new mastersheet for 
each. We also had two cases:
1. Left and right belong to the same content
2. Left belongs to different content than right

In situation 1, we used another mastersheet (B1), based on A1. We had the header on both pages 
in that case, creating coherence between the two pages. 
In situation 2, we had sheet B2, also based on A1. This one had two separate headers, creating 
contrast between the two pages.
For each section, we had a mastersheet for situations one and two.

I hope the idea and therefore also the importance of mastersheets has been clarified now. A 
mastersheet is kind of the backbone of your document, so don’t hesitate to put a little more 
time into it. It would be a pity if you had to redo a lot of work if you realised too late that your 
mastersheets are ineffective. 
If you do it well, you can e.g. also have the following editions of your magazine using the same 
mastersheets! Win win!

That was my intermezzo. Good luck with the rest of the workshop!
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You will see that the pagenumber from the B-master will suddenly appear. How this is the case, 
I will explain later. Also apply the new opacity on the other side, and apply it to your fun pages 
again. You will see that you have our very cool background.

Those were the basic princinples of mastersheets. They are especially useful while making big 
documents such as magazines or yearbooks, in which you want the layout to be consistent and 
use the same guidelines. For a yearbook I once made, we used 30 mastersheets for 168 pages. 
It saves a lot of time!

On the topic of saving time, there is a function you need to see. This is especially useful when 
you want to work with columns of identical size. I will let the images speak for themselves, but it 
is worth keeping in mind.

Layers
We just came across the problem that we 
could not see our pagenumbers anymore, as 
the background image was in front of it. This is 
because the background was on a higher layer. 
Recall from the intro: when something is on a 
higher layer, you can’t see objects below. We 
fixed it earlier by lowering the opacity, but this 
is quite a sad solution.

Really elegant designers, like you, will use 
layers. Go back to your B-master, and click on 
“layers”. Make a new layer by clicking on the 
‘new’-button (has a circle and contains a ‘1’ on 
the picture to the right. You will then see a new 
layer appear, with standard name “Layer 2”. 
Drag both the 2 text frames to this new layer.

If you go back to your C-master, you will see that 
these layers are also there. The backgrounds 

are still on layer 1, but the text remains on layer 2. If you bring back the opacity of the background 
to 100%, you will see that the page numbers remain visible. Super useful!

Layers namely work as follows: you have the same layers through all of your InDesign file (in this 
case: layer 1 and 2). These layers have, depending on which page you are working on, different 
contents. This allows you to easily keep the overview for each page. Within the layer, the same 
visibility hierarchy is used: the top element is visible first, etc. If you put something in layer 2 on 
the C-master, you will see that it can therefore cover your entire Mark Rutte Collage. 

To go in a bit more detail, our photopage has the following layers:

We now see that e.g. the Radboud University logo is above 
our annoying minions. If we want the logo to be behind our 
minions, we have to drag it below the minion picture in the layer 
1 hierarchy. There are even some more interesting buttons in 
your layer menu.
If you do not want to be able to move a certain item temporarily, 
you can ‘lock’ it (= not being able to move it until you unlock it). 
You can do that as indicated on the left.

Go back to the mastersheet. If you click on the empty space where the locks are on my picture, 
you will be able to lock the elements. This is for instance useful for backgrounds, etc. You can 
also toggle the visibility of an object by clicking on the eye icon. This is useful for when you want 
to temporarily remove an item from sight.
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Click on the eye icon on layer 1, and move back to the collage. You will see that it disappeared, as 
it was also on layer 1. I can definitely recommend to have a solid layer system when approaching a 
design project, giving them all useful names. It can’t really go too far: separate layers for “Pictures” 
and “Texts” is totally cool.

In my example document, I made some changes to the layers we had. I for instance made layers 
for “page numbers”, “content” and “backgrounds”. If you make the entire layer invisible, you will 
see that all contents on this layer will disappear. 

Colours and shapes
We’re nearly there. Before I make you do a cool assignment, you will first get some promised 
information on colours and shapes.

Always using black text is really boring: what if it could be in another colour? Surprise. You can. 
In InDesign you can edit to colours: the colour of the object itself, and the colour of its border. You 
do this as follows:

When editing the text, you can click on the two 
buttons as indicated on the left. The top one 
will always indicate the colour of the object, 
and the bottom one the border. I created a solid 
combination of blue text, with a very deliberate 
pink border.

You can also pre-set the text colours in character 
styles.

Let’s talk about shapes. In InDesign, you can use the following 
standard shapes: rectangles, elipses and polygons. You can 
select the shape of your choice by right-clicking the rectangle 
icon, as shown on the right. 

Then you can click and draw, just like with textboxes, to create 
your shape. Your object probably has no colour by default, and 
only a black border. You can edit this in the top bar, as learned 
before.

Life would be very boring without 
colour, and even so if you could 
only use the standard colours 
of InDesign. You can therefore 
also create your own swatches! 
They will from here on always 
appear in your colour pallet 
(in this document), so you can 
easily re-use them. 

Adding a colour is done as 
shown on the right.
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Closing assignment
That was pretty doable, right? You probably already know way more than you think. However, to 
put your skills to the test, I give you a sort-of free assignment to close of part A. You will go ahead 
and design your own CV! This is how you immediately stand out at your new employer, giving you 
a small advantage over the other candidates. 

I added some inspiration below (not my stuff), but feel free to design and decorate it as you wish. 
You do not have to, as learned before, already have the contents of your CV ready: it’s purely 
about the design now.

If done correctly, you will get a copy of the currently selected colour. If you then double click on 
the icon all the way on the right (indicated with red on the picture), you will open a ne menu. In this 
menu, you can edit the values of the colour. 

By default, this colour is in CMYK: the top of the shelf colour encoder of the printer world. If you 
prefer using RGB, you can also use that. However, I advise you to always use CMYK: a printer 
(also those on the RU) will namely convert your RGB colours to CMYK, sometimes leaving you 
with unwanted surprises. You can convert the RGB colour yourself to, to get an idea of what it 
looks like in CMYK. Shortly said: always use CMYK.

To close of with a fun fact: a shape is actually a frame just like a textbox, so you can also type in it.

Very blue, really clean. Some small details in the 
background and by using different font (styles), 
our friend Desiree implies a certain hierarchy 
within the document. She also puts emphasis 
on this using the blue rectangles on the left.

Jane over here knows how to effectively use 
colours, and that it can ‘direct’ people to the, ac-
cording to her, most important elements. What 
I regret to see, however, is that the “Emotional 
Intelligence”-box looks very empty. You are way 
better at this!

Tanya didn’t quite understand it: her hobbies 
don’t fit the box on the left. You must be way 
better at this already, even though she indi-
cates to be very good at InDesign. Funny. What 
she does, however, ace, is that she splits the 
document in a neat way.

Lastly, we have John. John clearly doesn’t pri-
oritize the quality of his pictures, but that won’t’ 
be a problem to you. He does however smartly 
uses different font styles to again give some hi-
erarchy to the document. He also uses a purple 
box to split the document neatly.
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Well done! You are now the owner of a Curriculum Vitae from the top shelf. What I did not explain 
so far, however, is how you export this. If you namely want to proudly present this CV to your 
parents or a future employer, they won’t exactly be happy with a .indd file.

Hopefully, you heard the term .PDF somewhere before in your life. I will now explain how you can 
save your file as a PDF! This way you can, very professionally, transfer your file on WhatsApp 
without the quality being downscaled, which usually is the case for pictures.

If you go to “File” -> “Export”, or simply press “CTRL + E”, you can select a filename. Leave the 
file-type on PDF for now. Afterwards, you will see this screen:

Closing A

It’s pretty much ready now. If you press export, you will very soon have a PDF file on the selected 
location on your computer. You can, if you feel like it, play around with the exporting options. 
Perhaps you do not want to export all the pages, but only a selection.

You can also print out your pages as “spread”: this way the pages will appear both left and right 
instead of separately. Useful for, for example, our pretty collage. This will make your document 
feel more like a booklet and you will have a better idea of what it will look like when printed as 
one. Have a brief look around in the menu, but do not worry if you do not know what it all means. 
If you are printing at a professional company, you will usually get a list with export settings your 
file should have.

That was part A! I hope you learned a lot from it. If you were not scared off for now, you can even 
continue with part B. 

See you there.
Jorrit

After bashing some CV’s left and right, it is finally time for some serious business. You are now 
one of the elite designers of the RU: welcome to the party.

As promised, we will be talking about:
• Advanced text options
• Groups
• More on Mastersheets
• Interactive PDFs
• Adobe Integration
• Exporting, printing, etc. for experts

I assume you already are quite up to date and know how all previously discussed themes work. I 
will therefore also put less screenshots in this part. If it is not completely clear what to do; feel free 
to ask me or Google.

Advanced text options
Textboxes are not a mystery anymore. But there are some options that you might normally miss 
out on.

Textwrapping
You probably know by now how you can make text follow a rectangular shape. However, what 
might be more interesting, is to have it follow the exact shape of another object. For this example, 
I took a Cognac glass. At random ;). Put the text and the picture in such a way that they sort of 
overlap, like below. Make sure that the picture has a transparent background. This is something 

Part B
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that most PNG pictures typically have. You can use png in your search query, or add ‘transparent’ 
as option like in the screenshot below. The more you know. 

Back to the Cognac glass. If you go to “Window” -> “Text Wrap” or press “CTRL + ALT + W” then, 
you will see a new window. If you click on the image, you will see that the top buttons are suddenly 
editable. Click on the middle icon: the ball in the center of some text. The options below will also 
appear to be editable now.

There were “wrap options” and “contour options”. With wrap options, you are able to choose how 
the text folds around the picture. Do you want it to only be on the left / right of the picture, or on 
both sides? Pick yourself. With contour options, you can choose how the text exactly folds around 
the picture. Do you want to fold around the frame of the picture, or around the contours of your 
image itself? If you select ‘detect edges’, InDesign will itself estimate the edges of your object. 
This will be fine 99% of the time, and your text will carefully follow the shape of your object.

Next, you can also edit the amount of space between the edge of the picture and your text. This is 
now ‘0p’, but feel free to play around until you like the amount of distance. For an optimal result, 
make sure that the text fills the box from left to right, as learned before.

References
Sometimes, you want to refer to a certain page on which a cool element is placed, such as a graph 
or a table. It might, however, be the case that you do not know on which page this piece of text will 
be placed, however. As you are still changing the contents. It would be awful to have to go back 
and check whether all page numbers are still correct, when finalizing your document. 

To always refer to the correct page, you can use a text variable (should sound familiar). Now you 
don’t want to add the current page-number, but the page-number of the relevant element. To de-
pict this, I summoned our yellow enemies again, the minions. 

If you want the ‘…’ to be replaced by the correct page number, you have to, as indicated on the 
picture in the bottom left, insert a cross-reference. Next, you click on the paragraph / piece of text 
you want to refer to. Click on “OK” to see what happens.
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It’s quite a pity that InDesign pastes an entire sentence, instead of simply the page number. We 
will change that. Go back to insert cross-reference, and copy this:

As you can see, the “Format” still said “Full Paragraph & Page Number”. That is a bit exaggerated. 
There are multiple options, but even “Page Number” doesn’t quite do it: it says “Page #”, and we 
don’t want the word “Page” popping up out of nowhere. On the right, you can edit the definition so 
that it behaves as desired. Click save and apply the cross reference. 

Wherever your minion image will go, the page number will always follow. How romantic. The ref-
erence now refers to the text below the picture, as this is the easiest. Feel free to look around and 
checking out the other linking options. You can then also refer to images.

Tables
You can even make tables in InDesign! It’s quite a simple trick. Go to “Table” -> “Insert table” or 
press “CTRL + ALT + SHIFT + T”. You can select, amongst others, the number or rows and col-
umns. If you press OK, you are expected to draw a rectangle in which you fit the table. Make a 
table of 7 by 7. We will recreate the following table, including colours.

You will see a few things in here: different cell heights, merged cells, different cell colours and 
even rotated text. There are many more possibilities, but if you know how to do these, you will also 
know where to look for the rest.

Let’s start with the different cell heights. If you select the text tool and hover over the table with 
your mouse, you will see that you can either type in a cell or move a line. If you do this, you will 
see that the other columns will move along to all give them the same width. If you only want to 
move a specific line without touching the others, make sure to keep pressing shift while dragging.

When selecting in a table, you must take into account that you are selecting either the content of 
a cell or the cell itcellf. That’s a pun by the way. Selecting the text may be useful for changing the 
character styles of your cell, and selecting the entire cell will be useful for when we are going to 
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change properties of the cell itself such as its colour. Try it out yourself: select a few cells and give 
it colour like you learned.

You can also, while selecting multiple cells, right-click and select merge cells. I did this to the top 
and right cells. I also clicked “centre text” for the top ones. You should be able to do that too by 
now.

Lastly, we have our vertical text. Type some-
thing in the cell, and select the entire cell (so 
not the text). At the top, you will be able to 
select the text orientation.

If you want to edit the settings of your table later on, then you can always to the following:
1. Select the cell as cell
2. Right click on the cell
3. Select “Table options” -> “Table setup”

If that’s too slow for you, you can also edit the amount of rows and columns in a faster way. A bit to 
the right of the text orientation button, you can find a button to edit those settings too. Make sure it 
fits within the frame you gave your table, otherwise you will get another one of those red crosses 
at the bottom of your frame indicating that your contents don’t fit your frame.

Groups
We have encountered quite a few cases in which we want some elements to be together, as they 
belong together. It would be ideal that if we move the picture, the caption moves with it and vice 
versa. It would be even better if they keep the same size ratio no matter how you resize them or 
move them. This problem screams for a solution, and it exists: groups.

Of course this is not only applicable to just images and captions, but to literally any combinations 
of elements. If you have found the perfect ratio for your elements, you can make them ‘friends’: if 
one leaves, the others does too. You can do so by selecting multiple objects and selecting “Group” 
in the menu that appears if you right-click. You can also simply press “CTRL + G”. You will see that 
there appears a dotted line around the objects.

You sort of created a new frame in which you do not capture one element, but multiple. You can 
move this frame and you will see that everything will move in the same ratio. Don’t worry, you can 
still edit the elements within the group: you can double click on the group and you will see that you 
can do what you always were able to.

If you ever regret grouping, you can ‘ungroup’ elements by pressing “Ungroup” or “CTRL + SHIFT 
+ G”. 

Grouping is applicable to many things, and you will certainly find a nice place for it. It’s a very ef-
ficient way to keep things consistent, which is what we like.

More on Mastersheets
There are a few things on mastersheets that I didn’t tell you before, just so I could keep it simple. 
But now you’re big and strong, I will show you the darker side of our greatest friends. Or some-
thing like that. I thought it sounded cool like this.

You might have encountered a case in which you applied a mastersheet to only one page (e.g. 
the right page), but that elements of the mastersheet also appear on the other (left) page without 

using that specific master sheet. If you didn’t encounter it, you certainly will in the future. Howev-
er, after this wall of text you will hopefully know how come and what you can do against it. I even 
encountered it when making this workshop file. I wanted to have a white bar on only the right side, 
but as soon as I made it overlap a bit with the left page, the white bar would also appear on the 
left page.

My mastersheet looks like this:

As you can see, the white bar touches both pages. Now comes the joke: as soon as InDesign 
thinks that a piece of an element is missing, it automatically loads in the entire other masterpage, 
even though all you wanted was a funky white bar that just crossed the page boundary a little. 
Some of the solutions I propose:
1. Just don’t have the element crossing the line
2. Cut the element in two (using e.g. Photoshop) and place the small bit of the bar on the other 

page.
3.  Make a new mastersheet combination for this problem.
There exist many alternatives; just do whatever you are comfortable with. If it works, it works.

Now something more positive on Mastersheets. May you ever want to break free from your mas-
tersheet for just one page, that’s possible too. You can edit an element from the mastersheet on a 
regular page by clicking on it with the selection tool while holding “CTRL + SHIFT”. Make sure the 
element is not locked in the layer window. The element now exists on your regular page.

Some design advice: it can be very cool to emphasize certain elements by making them jump out 
of the known location, but do not do this too often to maintain the consistency of your file. 

You can also use frames on your mastersheets. These are the boxes we have been working with, 
but then without any content. You can then easily e.g. make a textbox on each of the pages, as 
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InDesign will help you to re-use the of the frames for your to be created textbox. You can also, 
instead of making a new box on top of it, use the “CTRL + SHIFT” trick from a minute earlier to 
immediately start editing it. Useful!

One last tip for making large files: first work out your mastersheets and make some sample pages 
using place-holder photos and text, to get an idea of what your design will look like. If you make 
sure your mastersheets are cool before you start putting together the document, you save your-
self a lot of time.

Basics on Interactive PDFs
As explained before, PDFs are the best way to present your document to the outside world: your 
non-InDesign using peers. The peasants, essentially. If you make your files available digitally, it 
might be worthwhile to look into making your files more user-friendly by making them interactive. 
This could save them from scrolling, or copy-pasting URLs from your file.

We just learned ho to make a text-reference. You can then read on which page the minion is locat-
ed. But then what? You will have to scroll all the way down. What if you could click on the number, 
and automatically go to that page?

To do that, we need to work with ‘text anchors’. These are, as the name suggests, anchors in your 
text to which you want to refer. You will have to create these yourself, which is quite an adventure 
at first.

Open “Window” -> “Interactive” -> “Hyperlinks”. You will get a fairly empty and boring window on 
your screen. Before I will tell more about this window, I will share a cool trick. You can save win-
dows you use often, so that you do not have to reselect them all the time. So you can save them 
below your pages, layers, and links. This is all possible by dragging the top of your window to the 
bar on the right like below.

Right. The new window. If you click on the button I marked with red, you will see the option “new 
hyperlink destination”. This is how you make a new text anchor. Select the piece of text that you 
want to refer to, and actually click on the button I just mentioned. Make sure you selected “text 
anchor” and that you give your anchor a useful name, and you’re done. You have now made a 
‘target’ for your hyperlink. 

You can from here on make any text in your document refer to the text anchor you made. You can 

now in your hyperlinks tab click on “new hyperlink” while selecting a piece of text you want to use 
as link, and you can link it to the text anchor you just made. Your link-text should by default also 
get a hyperlink character style which you can specify yourself. 

If you export your document as a PDF (an interactive one), you can click on the link-text which will 
make the viewer jump to the page on which you mentioned the text anchor. Really nice.

This is the basics of interactive PDFs. As you may have seen, there are many other options under 
“Window” -> “Interactive”, with stuff such as buttons, fillable text fields, the list goes on. It’s defi-
nitely worth to look into if you want to bring your file to life.

Adobe integration
If you love your Photoshop and your Illustrator (etc.) and you would like to use them in InDesign, 
then you could convert them to a PDF or image to add the file as we’ve seen before. However, if 
you then still want to make edits to your photoshop file, it is very annoying to have to save it all the 
time. Not only does it cost time, it also costs a lot of space on your PC. 

Our friends at Adobe have come with the solution: you can directly import your .psd and .ai files 
in InDesign. If you then click “Edit original” or “Edit with….”, you can use your preferred piece of 
adobe software to edit contents as you wish. If you save it again, you will see that it updates au-
tomatically in InDesign. What a time to be alive.

Advanced exporting, printing, etc.
Earlier on in this workshop, you learned how to export documents easily. There are so many op-
tions, that I will devote a section on how to start and end a document in a good way.

Numbers
When printing, your number of pages should always be a multiple of four. That is because, imag-
ine your page size is A5, the printer will print on an A4. They will then fold it, so it becomes an A5. 
There are two pages on the front, two on the back: that adds up to 4. This forces out that you will 
have to have a multiple of 4 pages.

Afloop
Professional printers also want you to use bleed in your documents. It works like this: if you print 
a lot of pages and fold them in half, you will see that the sheets more in the middle will stick out 
more, relatively to the ones on the outside. The printer will cut this off to make the edge of the 
book straight. However, to not lose any essential information, they want you to design a (usually) 
5mm border around your sheet. This is usually all cut off, but sometimes 1-2mm of this border is 
visible. You thus have to design a little bit bigger page to make sure it is cut off fine. Lots of text. 
Here’s a picture.
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This is how you will see bleed in InDesign. The purple lines are where your most important con-
tents should be, and the red border, the new one, indicates the bleed. If you make sure your im-
ages follow the red line (and not the borders of the sheet), your printed result will look like the left, 
not like on the right (see picture below).

You can set the bleed in “File” -> “Document setup”. Make sure that all your contents (images, 
backgrounds, etc.) are accounted for in the bleed, and your document will look much more pro-
fessional.

Links
It is also very important that your images are of a 
decent quality. You don’t want to invest a lot of mon-
ey into a magazine with pixelated images. A good 
file uses 300 “pixels per inc” or 300 ppi. However, 
the quality is dependent on how far you zoom in on 
the image. You can ruin the best pictures by zoom-
ing in x400, and you can publish the worst photos if 
you do not make them to small. What we need, is a 
measure of “good enough”-quality.

If you go to the “Links” tab on the right of the screen, 
that tab below “pages” and “layers” what you have 
been ignoring the entire time. Clicking on it will give 
a list of all the files used in the document. You can 
click on a specific image (not on the orange page 
number, that will namely send you to the page it is 
used on), giving you a lot of information on the im-
age and its quality.

What we are looking for, is the “effective ppi”. If this 
value is above 150, you will get it past most printing 
companies; this is a common value for the effective 
ppi. 

Exporting
If your piece of art is finally ready for exporting, it 
is important to also export the bleed settings, etc. 
Some printers also want you to export the crop 
marks. Below is explained how to do so. This will 
hopefully save you a couple of hours of searching 

(that was an indirect burn to my previous printer). 

Make sure you enabled the following options in the exporting menu:

Your standard will probably have to be PDF/X-3-2002. This is kind of like the Formula1 among 
the PDFs: good stuff. The crop marks will make it so that the printer doesn’t have to add it them-
selves, and the bleed settings will include all of the extra information that you included to make 
your document cleaner.

I’m not saying that every printer wants to get the file exactly like this, however these are very 
common settings of files. Not every printing company presents you with a list of settings, so here 
you go. This should probably do in most cases. If you deliver it like this, they will probably accept 
it and this will save you some back-and-forth emailing.

Final assignment
Woah. You made it. You are quite good at it too! To really prove yourself, I will give you one final 
assignment. 
Make a magazine on a topic of your choice, with the following elements::
• A modern front page
• A photo collage
• A puzzle page
• An advertisement of your study association
• An interview with your favourite artist using text wrapping
• A recipe of your favourite dish
• A review of an event
• A colofon

It, again, is not about the contents, but purely about the design. Choose your mastersheets wisely, 
and think of an interesting way to display the information you are presenting. Make it a piece of 
art. What follows can serve as inspiration!
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I’m just stealing these from Google by the way. Definitely look for more yourselves. I found that 
these make great use of colours, borders and fonts.
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Leaving space can also be beautiful. Do not always fill everything to the brim! (Look up Horror 
Vacui) Oh well. You will be fine. Enjoy!
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End of the Workshop
That’s it for now. As said before, you are now part of the RU InDesign elite. Well done. You now 
have all the tricks up your sleeve to make the best almanacs, brochures and what not. The only 
limit is your creativity. 

May you forget something, you can always look it up online: InDesign is a very common piece 
of software and an active forum where users ask and answer questions. Next to that, there are 
many people that like explaining InDesign just like me, so don’t hesitate to look up some tutorials 
/ workshops online.

Lastly, I can only say that you will learn it by putting in the hours. At some point, making a textbox 
is more of a routine thing than something you think through. Your first design will definitely not be 
your best, but you can always edit it later on. Being open for mistakes and learning from them is 
the best quality of a great InDesigner. Also for life by the way. Deep stuff.

I might have already said it too much, but I truly hope you enjoyed this workshop and that you 
learned a lot. Me too! I hope some of you will be sparked with inspiration and perhaps make 
there presentations and projects in InDesign from now on. Or maybe even the minutes of your 
committee. 

To end off on a happy note (that’s a Dutch saying at least), here you have an applicable meme. 
It’s one of those super old 9GAG-format memes which I normally hate, however I found it the best 
way to end this workshop. I’ll let it slide.

Enjoy.

Jorrit




